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Another common type of computer is 
the desktop computer that you usually 
find in offices, businesses, and school 
computer labs. These are bigger, 
clumsier devices.

All of these computers can do many 
different things (they are multi-purpose) 
and so they can be used as tools 
to help us complete a wide variety 
of tasks better and faster. They are 
also all electronic devices (they need 
electricity to work). The first three 
devices (laptop, smartphone and 
tablet) are made to be portable or 
mobile (i.e. you can carry them around). This means they have to run on batteries, 
which need to be recharged periodically.

Computer Applications Technology (CAT) is a subject that focuses on learning how 
to use computers effectively. We all love to be ‘hands-on’ as soon as possible. 
However, it is important first to understand some of the jargon or terminology, and 
to have a very basic idea of what is happening behind the scenes. So this module 
will serve as a quick starter pack to teach you the very basics of computers.    

What is a computer?
The picture below shows you the three types of computer that you are most likely 
to see in use around you in everyday life, namely laptops, smartphones and 
tablets.    

What is a computer?
Hardware and software
The information 
processing cycle

Introduction to 
Windows

Start-up time 
The desktop
Common features of 
programs

Saving our work
Introduction to the 
keyboard 

The keyboard (input) 
Keyboard skills

Introduction to 
computers

Module 1.1

Most desktop computers have several 
components that need to be connected 
to each other. 

These are not the only 
types of computers you get, 
but rather the ones you are 
most likely to have used or 
seen.
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Although there are different types of computers, they all need hardware and 
software to work.

Hardware and software 
We refer to the physical parts of a computer that we can touch and see as 
hardware. Examples include the mouse, the monitor, the keyboard, a printer and 
the different parts found inside the computer box.

To get the computer to do something useful, we need to give it very specific 
instructions. These instructions are what we know as programs or software. 
Another word that has become common for a specific program is ‘app’ (short 
for application). ‘App’ was originally used to describe programs used on 
smartphones and tablets but is now used for almost any kind of program.  

It is the ability of your computer to run different 
types of programs that makes it a multi-
purpose tool. Using the same hardware you 
can load a game program (or a music player 
or a video player) and use your computer 
for entertainment – or you can load a word 
processor and type out a document – or you can load a graphics program and 
create a picture – and so on. There are many different types of programs, which 
allow you to perform completely different tasks using the same hardware. 

All computers are made up of hardware and software (programs). What is also 
important is that they all work in the same basic way – according to a cycle 
known as the information processing cycle.

The information processing cycle
Computers receive input – usually from the keyboard or the mouse, 

do something with it (process it), and then 

produce some form of output – usually on the screen or on a printer. 

Often the output needs to be stored for use later. 

The apps on your smartphone 
enable you to do much more with 
it than just make phone calls. This 
is why a smartphone can also be 
regarded as a ‘computer’.

Input Processing 
of data

Output

Storage
(permanent)
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As an example of the information processing cycle, consider the process of adding 
a contact to your smartphone:

These days most computers are linked to other computers in some way, so that 
they can communicate with one another. Communication has therefore also become 
a very important element in this cycle.

Input
Type in the 

contact’s details 
using the keyboard

Processing
Smartphone 

checks if it already 
has the contact

Storage
Contact stored if necessary

Output
Message 

displayed on 
screen showing 

that contact exists 
or has been added

We use computers to process data into information.
•	 Data is unprocessed items. This can include text, numbers, images, audio 

and video.
•	 Information is the result of the processing of data and should be useful 

and meaningful.
A learner’s learner number and test and exam marks is an example of data 
input. After the data has been processed, the result or output is a printed 
report (information) which indicates whether the learner fails or passes, and 
what the learner’s average is. This information is more meaningful than the 
raw marks would be. 

50
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When you send or 
receive an email or 
when you browse the 
web or download an 
app, your computer is 
communicating with other 
computers.
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1.	 Write down the names of the four types of computers mentioned in this module.

2.	 Which one of these types of computers is not ‘a single piece of equipment’ (i.e. it is 
made up of separate parts connected to one other)?

3.	 Distinguish between hardware and software.

4.	 What makes a computer a multi-purpose tool, i.e. able to perform different tasks, 
such as playing a video or letting you type out a document?

5.	 Categorise each of the following items as either hardware or software:
a)	 Screen

b)	 Computer game

c)	 Microphone

d)	 WhatsApp

6.	 List the main steps in the information processing cycle or ‘the way that a computer 
works’.  

7.	 Indicate in each of the following cases whether the phrase or definition refers to 
input, output or storage:    
a)	 Typing a WhatsApp message or an SMS. 

b)	 A ‘please call me’ from a friend displayed on the smartphone’s screen.

c)	 Music that you listen to on your headphones.

d)	 Photos on your phone.

e)	 Touching your phone’s screen to start an app.

f)	 Printing a document.

g)	 The movie on a DVD.

8.	 Distinguish between data and information.

1 Activity

Introduction to Windows
The most important program on a computer is the one that controls all the activities 
in the computer. This is known as the operating system, and Windows is probably 
the most well-known operating system. In this section we are going to explore the 
Windows environment a bit.

Start-up time
The operating system automatically loads when the computer is switched on. We 
call this the booting process. Depending on how your computer is configured (set 
up), you may have to press <Ctrl><Alt><Delete> to log on. In addition, you may be 
asked to enter a username and password. 

Logging on is the process of getting access to the programs and data on a computer, 
which are protected with a username and password.
This is necessary when many people use the same computer, and when a computer is 
linked to several other computers in a network (as you most likely have at school). 
The use of a unique username and password is for security purposes – so that only 
YOU can access your files. Other users must not be able to view, tamper with or delete 
your files. 

Distinguish means that 
you need to say how two 
items that have a lot in 
common, differ from each 
other.

Categorise means that 
you have to say in which 
group an item fits.

Windows is not the 
only operating system 
available. Your phone 
or tablet probably uses 
either Android or iOS, 
and desktops and 
laptops can also run 
Linux or MacOS instead 
of Windows
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The desktop
When you switch on your computer, you will eventually see the desktop. This is 
the first basic ‘screen’ of the operating system. It will often vary in appearance, 
as each operating system looks slightly different, and the desktop can also be 
customised or changed by the user. The tiles (bigger rectangular blocks) and the 
smaller pictures or icons on the desktop itself, represent programs or ‘places’ on 
the computer.

Start button TaskbarQuick Launch toolbar Notification area

All modern software makes use of a graphical user interface or GUI, (pronounced 
as ‘gooey’). This allows users to interact with the computer (actually the operating 
system), and to make selections through the use of graphical elements such as 
icons and tiles. 

A GUI is designed to be used with a keyboard and mouse (or a finger or hand in a 
touch screen environment). Here are some common mouse actions:

Clicking	 Resting the pointer on an object and then selecting the object by 
clicking the left button once. 

Double-clicking	 Quickly clicking the left button twice.

Right-clicking	 Clicking the right mouse button instead of the left mouse button.

Dragging	 Clicking on an object, holding down the left mouse button and 
moving the mouse. The object will move along with the pointer. 

Scrolling	 Most mouses have a wheel between the two buttons, which is 
used to scroll up and down in a document on the screen. 

Select means to choose 
something to be able to 
work with it. Many people 
refer to this (incorrectly) 
as ‘highlight’.
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•	 Switch on your computer and log on. Wait until the desktop appears.

•	 You will see icons (or, if you click on the Start button, tiles) that represent 
objects such as programs. 

•	 Rearrange some of the icons on the desktop by dragging them. 

•	 Rest the pointer on some of the icons. We call 
the description that appears when you rest or 
‘hover’ your pointer on an object a tooltip. Read 
the description that appears for an icon such as 
the Recycle Bin.

•	 Right-click on the Recycle Bin. A list of options 
will pop up. This is known as a pop-up menu. To 
remove this menu, click on an open part of the 
desktop. 

•	 Some pictures or icons have a small curved 
arrow in the bottom left corner. These icons are 
known as shortcuts. See if you can identify a 
shortcut on your desktop. Shortcuts provide fast 
access to programs, files, printers, etc. 

•	 Click on the Start button. Notice how some of 
the options have a small triangle next to them. 
This simply means that there are more options 
to be found on another menu. 

•	 An important option located on the Start menu 
is the option to Shut down the computer. (Do 
not select anything yet!) 

	 It is important to use this option to switch off the 
computer. If you use the power button to switch 
off the computer, it could damage files that are 
still open, and the computer might not save changes to documents and 
settings in programs that are still running. 

You can sometimes cancel an option or get back to where you were by pressing the 
Escape key (<Esc>).

2 Activity: Exploring the desktop

Common features of programs
Programs written to run 
on a computer that has 
a Windows operating 
system are called Windows 
programs. When a new 
program is started, an area 
on the screen is used to 
display the feedback or 
output from the program. 
This area is known as a 
window. 
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•	 To complete this activity you first need to watch the video 
WindowsMod1_1Act3.mpg. The video discusses the basics of the user 
interface in Windows, including: 

-	 Title bar   

-	 Active window 

-	 Taskbar 

-	 Resizing or moving a window

-	 Window control icons at top right

•	 Open the Microsoft Word program. 

•	 Also open Paint. 

•	 Maximise both programs and see if you can switch between them, using the 
taskbar.

•	 Now resize the two windows (use ‘Restore Down’) and place them next to 
each other on the screen. (They should only touch – not overlap.)

•	 Try making the windows wider or narrower by dragging their borders and/or 
corners.

•	 Close the windows, using a different ‘close’ procedure for each one.

3 Activity

Title bar – shows the name of the file and the 
program you are working in.

Minimise, Maximise 
and Close buttons 
– used to minimise, 
maximise and close 
windows. (Note that 
Maximise changes to 
Restore Down if the 
window is already 
maximised.)

Ribbon – a 
combination 
of menus and 
toolbars. 

Scrollbars – let you scroll up or down (or across) the window 
to see parts of the document that may not be visible due to the 
size of the window.

Let’s explore some features that are common to all applications. 

As we have already seen, Windows programs have similar features. The following 
typical components of a window are shown in the screenshot below: 
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In all the Microsoft Office applications the separate menus and toolbars have 
been combined into a new type of component – the Ribbon. The Ribbon has the 
commands organised in logical groups on different tabs (such as the Pages, Tables 
and Illustrations groups on the Insert tab of Word). 

Match each of the terms in Column B with the description in Column A.

Column A: Description Column B: Term

1 A mouse action that causes a pop-up menu to appear A	 Start button

B	 Desktop

C	 Drag and drop

D	 Esc key

E	 Click

F	 Icons

G	 Restore Down

H	 Right-click

I	 Maximise

J	 Booting

K	 Minimise

L	 Operating system

M	 Ribbon

N	 Scroll

O	 Delete key

P	 Shortcuts

Q	 Taskbar

R	 Title bar

S	 Tooltip

T	 Window

U	 GUI

2 A tip or information that pops up when you rest the pointer on an icon 
or object

3 Using a mouse to move up or down in a document

4 A mouse operation to move objects

5 The most important program, that controls all activities in a computer

6 The first basic screen that appears when Windows is loaded 

7 The process of starting a computer and loading the operating system

8 The small pictures on the desktop which represent programs or 
‘places’ on the computer 

9 The bar at the top of a program/window that displays the name of the 
file and the program you are working in

10 A combination of menus and toolbars into a new component used in 
Microsoft Office

11 The horizontal bar at the bottom of the desktop, which holds 
minimised programs 

12 Pictures or icons which have a small curved arrow in the bottom left 
corner

13 The key used to cancel an option or get back to where you were 

14 A rectangular area on the screen used to display the feedback or 
output of a program 

15 An action which reduces a window to a button on the taskbar

16 An action which makes the size of a window as large as possible

4 Activity

Groups

Tab
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Saving our work
When you work on paper you have a permanent record of everything you 
do. In fact, should you decide that you no longer want the record of the work 
that you have done on the piece of paper, you have to purposefully destroy 
that record (e.g. throw away the paper on which it is written) in order to get 
rid of it. Computers work just the opposite way. Work currently being done on 
a computer is kept temporarily in memory – and it stays there (in memory) 
only as long as the program is open and the computer 
is switched on. To keep that work so that you can use 
it again later you have to save the work to storage. 
Everything that is saved on a computer (Word documents, 
drawings done in Paint, etc.) is saved in files. You 
organise files by grouping them into folders.  

It is important that both files and folders should have meaningful names that 
describe what is kept in them. So when you get to save a file, you should never 
call it ‘myfile’ or ‘file1’ but rather something like ‘CAT Mod1_1 Act5’. Yes it takes 
a little effort to name your files properly, but the big advantage is that you will 
always know what is in the file – especially when you look for it later.

A file is a collection 
of data or information 
that is stored on a 
computer under a 
single name.

Sometimes you may wish to create a drawing to put in a document. We are going 
to use the basic drawing program Paint to have some fun – and to practise saving 
our work. 

•	 Open the program Paint. 

•	 What you have now is really a ‘blank 
drawing’. 

•	 Rest your cursor on each of the icons in 
turn, to see the tooltips describing their 
functions.

•	 Move your pointer to the bottom right 
corner of the white rectangle, and you 
will see that it changes to a two-headed 
arrow. (It is possible that your ‘blank 
drawing’ is initially a very small area.)

•	 Drag the pointer downwards to the right to make 
your drawing bigger.

•	 Now have some fun exploring and drawing – you will learn 
some cool things from one another! 

•	 Do the following to save your drawing:

	Click on File at the top left.

	Select the Save option to save your work as a file. 
(Remember – everything we work on is saved in 
files.)

	Type in a descriptive file name for your drawing and click on Save. (Your 
teacher may give you further instructions as to where specifically to save 
your file.)

5 Activity

You will learn more about 
files and folders in Module 
1.4 on p. 40.
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Introduction to the keyboard
At the moment the keyboard is still the most commonly used input device. It 
allows us to type information into the program that we are using. 

The keyboard (input) 
The type of keyboard that is most commonly used with desktops and laptops is 
known as a QWERTY keyboard because of the first six letters on the top row 
of alphabetic keys. On smartphones and tablets the keyboard is displayed by 
software on the screen – which allows you to change the keyboard to display 
letters alphabetically rather than in the QWERTY order.

•	 Now close the program (window).

•	 Try re-opening the file by reloading the Paint program and selecting the Open option 
on the File menu.

•	 Make some changes to the drawing, then save it under a different file name by 
selecting the Save As option on the File menu.

Being a really competent computer user refers not to how fast you can type, but rather 
to your ability to use the mouse and keyboard expertly in conjunction with software.    

More important than the name of the keyboard is the fact that most of your time 
spent working with a computer involves entering text. That means using a keyboard, 
and the better you are at doing this, the more efficient you will be as a computer 
user. That means you need some serious keyboard skills!

Keyboard skills
People who are really good with the keyboard can type without looking at the 
keys. They can type at speeds of over 120 words per minute – all without making 
mistakes! We say that such people can ‘touch type’. 

Touch typing involves the use of all the fingers on both hands. You hold your hands 
over the keyboard and then only use specific fingers for specific letters. This is a 
practical skill – and the more you practise, the better you will become at it. Luckily 
you get Typing Tutor software that teaches you how to touch type and helps you 
practise.  

Using the mouse to do 
things like saving a file 
or applying formatting to 
text (e.g. making it bold) 
can really slow you down. 
Learn keyboard shortcuts 
instead!
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What is a computer?
•	 Electronic (because it needs electricity to work)

•	 Multi-purpose (can be programmed to perform different tasks)

•	 Some are mobile (laptops, tablets, smartphones)

•	 A smartphone is also a ‘computer’

•	 Desktop computers have separate parts (components) that need to be connected to each other

•	 Two critical components: hardware and software 

-	 Hardware refers to the physical parts of a computer that we can touch and see – the mouse, 
the screen, the keyboard, a printer, etc.

-	 Software refers to specific instructions or programs we need to give to the computer so that it 
will do something useful for us.

•	 Information processing cycle: Computers receive input, process it and then produce some form 
of output. Often the output needs to be stored for use at a later stage. Communication with other 
computers is also important. 

•	 Data and information

-	 Data is unprocessed items. This can include text, numbers, images, audio and video.

-	 Information is the result of the processing of data and should be useful and meaningful.

Introduction to Windows
•	 Operating system – Most important program that controls all activities in a computer.

•	 Booting up – The process whereby a computer starts up and loads the operating system. This is 
initiated by the user. 

•	 You may need a password/username to log onto Windows.

•	 The desktop is the first basic ‘screen’ of the operating system.

•	 GUI: Graphical User Interface designed to be used with a keyboard and mouse (or a finger or 
hand in a touch screen environment).

•	 Mouse actions

-	 Left-click: generally used to select something

-	 Right-click: generally brings up a pop-up menu with options related to the current activity

-	 Double-click: generally used to open a file or folder, or to run a program 

-	 Drag: generally used to move or resize an object

•	 The taskbar, Start button, shortcuts, icons, Recycle Bin, Notification area and Quick Launch 
toolbar are all located on the desktop.

•	 <Esc> key can be used to cancel an option or get back to where you were.

•	 Use the Start menu to shut down the computer.

1

Summary – concepts, terms and tips

Test and improve 
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Saving your work   
•	 File: A collection of data or information that is stored on a computer under a single name.

•	 Storage: Place on a computer where work is kept permanently.

•	 Memory: Place on a computer where work is kept temporarily, while we are still working with it 
and before we save it to storage.

Introduction to the keyboard 
•	 Most common input device, used to type in text or data

•	 QWERTY refers to a standard ‘full’ keyboard

•	 Touch typing – typing using all fingers on both hands, without looking down at the keyboard

•	 Practising with a Typing Tutor – important to improve keyboard skills

Written module activity 

1.	 Give two differences between a laptop and a desktop computer, apart from their different 
sizes.

2.	 The hardware part of a computer – considered on its own – is not much more than a big 
doorstopper or paperweight. Explain then how a computer can be the incredibly useful 
multi-purpose tool that it actually is.

3.	 Where else can the computer ‘send’ the results of processing other than to ‘output’?    

4.	 Explain the difference between data and information by referring to a practical example 
(other than the one used in this module). 

5.	 Why does a computer need an operating system?  

6.	 Every time a friend tries to select something in Windows, a menu pops up instead. Explain 
to her what she is doing wrong, and what she should be doing instead.   

7.	 The functions of some icons are easy to work out by looking at their pictures. Give a quick 
way to find out what an icon does if the picture itself does not give you a clue.

8.	 Where else can you look for a program on a computer if there is no shortcut for it on the 
desktop?

9.	 Where can one find a window that is currently minimised? 


